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 : تهیه و تنظیم
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 Microsoft Wordجزوه آموزش 

 

 ذخیره سازی  ، باز کردن  و ایجاد فایل جدید

 

 ایجاد کردن یک فایل جدید:

 روش ها :
1-File > New > Blank document 

 از نوار ابزار  Newانتخاب دکمه -2

3-Ctrl+N 

 دهید. فشاررا باهم   Nو  Controlهای  یعنی کلید
 

 : ذخیره کردن یک فایل
1-File >> Save As 

را مشاهده نمی کنید منو را توجه : در صورتی که هنگام جستجو در منو ها ، گزینه مورد نظرتان  -

Expand  بزرگ( کنید(. 

 از نوار ابزار  Save انتخاب دکمه -2

3-Ctrl+S 
  doc.خواهند بود و پسوند آن ها   document    اسم پیش فرض فایل ها -

 : باز کردن یک فایل
 

1-File > Open 

 از نوار ابزار   Openانتخاب دکمه -2

3-Ctrl+O 
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 آشنایی با محیط برنامه
 

 
 

 
 

 یی

 
 

   

  

 

 

 

 

 نوار عنوان

 نوار ابزار

 نوار وضعیت

 خط کش ها

 نوار ابزار استاندارد
 نواز ابزار فرمت

نوار ابزار  

 رسم جدول
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 تنظیمات صفحه :

File >> Page setup 
Margin حاشیه 

Gutter  شیرازه 
Orientation:   portrait (عمودی), landscape )اففی( 

 

Paper tab 

Paper size : ابعاد کاغذ 

 دیده می شود. انتخابیپیش نمایش کاغذ  پنجرهدر قسمت پایین ، سمت راست این  -

 .برای همیشه باقی می ماند انتخابیتنظیمات  Defaultدر صورت کلیک بر روی  -

 

 خط کش ها:

view >> ruler      فعال یا غیر فعال کردن خط کش ها  

 

 مرز آبی رنگ قبل از خط کش ها نشان دهنده حاشیه صفحه است.

 تعیین واحد اندازه گیری:

 
Tools > Option > General > Measurement units > Centimeter  

 اعداد به صورت فارسی  ا تایپ در صورت مشکل ب
Tools > Option > Complex Script >> Numeral > context 

 

 قالب بندی متن:

  با استفاده از نوار ابزار فرمت  -1

 برای افزایش یا کاهش  یک واحد ، یک واحد در سایز فونت :
Ctrl + [ 
Ctrl + ] 

Blod   Ctrl + B 

Italic  Ctrl + I 

Under line   Ctrl + U 

Align: 

Center   وسط چین  Ctrl + E 

Left  چپ چین  Ctrl + L 

Right  راست چین Ctrl + R 

Justify طراز از دو طرف Ctrl + J 
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 برای اعمال هرگونه تغییرات باید ابتدا متن یا شی مورد نظر را انتخاب کرد wordتوجه : در  -

 

 دقیق متن  قالب بندی

Format > Font    (Ctrl + d). 
Font Tab: 

Latin text    به متن های لاتین  مربوطفونت  

Complex script    فونت های مربوط به زبان فارسی 

Font color  رنگ قلم 

Underline style     طزیر خنوع  

Underlin color طزیر خ رنگ  

Effects   
Strike through خط زدن    

Double Strike through   مضاعفخط زدن  

Super script متن انتخاب شده بالاتر از خط زمینه قرار می گیرد 

Sub script متن انتخاب شده پایین تر از خط زمینه قرار می گیرد 

Shadow سایه دار شدن متن 

Out line تو خالی کردن فونت 

Emboss  برجسته کردن فونت 

Engrave تو رفتگی فونت      

Small Caps    حرف اندازه اولینبزرگ کردن  

All caps   کردن حروف بزرگ  

Hidden  مخفی کردن متن 

 می کنیم.  Hiddenبرای مخفی کردن متن ابتدا متن مورد نظر را انتخاب کرده سپس آن را 

 برای دیدن متن مخفی شده
Tools > option > view >Formatting marks> Hidden text  
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Character Spacing Tab 

Scale کاراکتر ها کشیدگی  

Spacing فضای بین کاراکتر ها   

 

 

 
Position  

 

 

 
Text Effect Tab 

 نافکت های مربوط به مت

 این افکت ها در چاپ مشاهده نخواهند شد. -

 

 را انتخاب کنید     line spacingبرای تعیین فاصله بین خطوط از نوار ابزار فرمت دکمه    -

 :پاراگرفتنظیمات مربوط به 

Format > Paragraph 

Alignment تراز بندی 

دو نوع تراز بندی وجود دارد. تراز بندی  چپ  برای متن های لاتین و راست برای متن های 

 فارسی

- Word  جهت متن (direction) .را به صورت اتوماتیک تعیین می کند 

 

Indentation تو رفتگی 

Before text  تو رفتگی از سمت چپ 

After text تو رفتگی از سمت راست 
 

 

Specianl  

  

 

 

 

Normal معمولی 

Expanded     فاصله بین کاراکتر ها زباد می شود  

Condensed بین کاراکتر ها کم می شود فاصله  

Normal معمولی 

Raised   ر از خط زمینه قرار می گیرندکاراکتر ها بالات  

Lowerd کاراکتر ها پایین تر از خط زمینه قرار می گیرند 

First line تو رفتگی برای خط اول پاراگراف   

Hanging  تورفتگی مربوط به خطوط دیگر پاراگراف 

Before  فاصله از پاراگراف قبلی 

After فاصله از پاراگراف بعدی Line Spacing 

Single   حالت پیش فرض 

1.5 lines  1.5 برار  

Double  دو برابر 

At least  حداقل 

Exactly  ازه دقیقاند  

Multiple چند حالته 
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Spacing 

 

 ایپ !شروع به ت ازقبل چند نکته 

را راست  alignو  (right to left)را راست به چپ  direction در صورت تایپ فارسی حتما  -

(right)  .برای راحتی از  بگذاریدCtrl + Right Shift .استفاده کنید 

در یک پاراگراف برای رفتن اده کنید. پس استف Enterبرای ایجاد یک پاراگراف جدید از کلید  -

آن خط را یک پاراگراف تلقی می  word  استفاده نکنید زیرا Enterبه خط بعد از کلید 

 استفاده کنید. Shift+ Enterبرای رفتن به خط بعد از  .کند

 استفاده کنید. Ctrl+ Enterبرای شکست صفحه  )رفتن به صفحه جدید( از  -

 

 

TAB ها 

 وع تب وجود دارد:ن word 5در 

Decimal Tab   تب مربوط به اعداد 

Center Tab تب در حالت وسط چین    

Left Tab تب در حالت چپ چین      

Right Tab تب برای حالت راست چین    

Bar Tab تب جدا کننده     

  Tabبرای ایجاد یک  

 می توان تب ها را تغییر داد.در گوشه سمت چپ نوار ابزار خط کش با کلیک  

 رای اضافه کردن یک تب کافی است در محل مورد نظر روی نوار خط کش کلیک کنید.ب

 می کنیم. Dragکردن تب ، تب را به سمت داخل صفحه  حذفبرای 

 به تب ها مربوطبرای انجام تنظیمات 
Format > Tabs 

 است که می توانید به دلخواه خود آن را تغییر دهید. cm 1.27اندازه اولیه برای هر تب 

 ابزار اختصاصی ساخت یک نوار

 را انتخاب می کنیم.  customizeروی نوار ابزار راست کلیک کرده و سپس 

کلیک کرده ، یک نام برای نوار ابزار خود تعیین می کنید و از تب  Newدر پنجره باز شده روی 

Command   باdrag ، اضافه می کنید.خودتان باشد را  رنوار ابزاابزارهایی که می خواهید در  کردن 
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 برای تایپ فرمول های ریاضی:  Equation Editorاضافه کردن  ابزار 

در پنجره مربوط به تب   را انتخاب می کنیم.  customizeروی نوار ابزار راست کلیک کرده و سپس 

Commands   ،Category   مربوط به  Insert  را انتخاب و در لیستCommand    به دنبالEquation 

Editor    می گردیم ، سپس با عملdrag  .آن را روی نوار ابزار قرار می دهیم 

 

 

 روش های کپی :

 ، سپس :   (highlight)می کنیم  بانتخاابتدا متن مورد  نظر را 

 را انتخاب می کنیم.  Copy:  راست کلیک کرده  و  1روش 

 می کنیم. بانتخارا   copyینه ، گز  Editاز منو : 2روش 

 Ctrl+ C:  3روش ش سریع ()رو

 کردن متن کپی شده :  pasteبرای  

 را انتخاب می کنیم.  pasteراست کلیک کرده  و  -1

 می کنیم. بانتخارا  pasteینه ، گز  Editاز منو  -2

 Ctrl + V )روش سریع ( -3

کردن   Dragو   Ctrlدکمه  نگه داشتن می توان  با انتخاب متن مورد نظر  ، سپس با -

 را همزمان انجام داد. pasteپی و موس دو عمل  ک

 می شود. به جای کپی ، جابه جاهمانند کپی است اما متن انتخابی  (Cut)روش های انتقال 

 کرد. Dragمی توان مستقیما متن انتخابی را  لبرای عمل انتقا

 

 عبارت در متن: و جایگزینی یک  یافتن 
Edit > Find (Ctrl + F) 
Find Tab: 

Find what :   جستجو جهتارت مورد نظر عب  

 می شود. highlightعبارات پیدا شده ،   …Highlight all Item found inدر صورت تیک زدن 

 می توانید جستجو را محدود کنید moreبا زدن دکمه 

Match Case   حساس به حروف کوچک و بزرگ 

Find Whole Words Only  .عینا کلمه تایپ شده جستجو می شود 

Use Wildcards   استفاده از قواعد جستجو 
Replace Tab    ( Ctrl + H) 

Replace with .کلمه پیدا شده را با کلمه جدید جایگزین می کند 
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  :نشانه گذاری
Insert  > Book Mark 

 می کنیم okرا می زنیم و   addانتخاب کرده ، سپس دکمه  book markیک نام برای  ابتدا

 

 ایجاد لینک :

 را انتخاب می کینم. Hyper Linkورد نظر را انتخاب کرده ، سپس راست کلیک کرده ، م یا شی  متن

 
 

      ایجاد لینک برای قسمت هایی از متن

 تعریف می کنیم Book Markبرای قسمت های مورد نظر  -1

 hyper linkعمل لینک را برای متن مورد نظر انجام می دهیم با این تفاوت که در پنجره  -2

 را انتخاب می کنیم. Book markگزینه 

 Useرا نگه داریم در غیر این صورت باید تیک  Ctrlنکته : برای  اجرای لینک ها ، باید دکمه 

control + click to follow link   : را  از آدرس زیر برداربم 
Tools > Option > Edit > Editing Option  

 

 Drawingکار با نوار ابزار 

 رسم می کنیم.  drawing کل را در خارج از کادریک شکل ، ش هنگام ایجاد -

 Dobleبرای اینکه به تعداد زیاد ، یک شکل را به وجود بیاوریم روی ابزار شکل مورد نظر  -

Click .می کنیم 

را نگه می  Shiftابتدا ابزار رسم بیضی را انتخاب می کنیم و کلیک  ،برای رسم دایره  -

 داریم.

را نگه می  shiftسم مستطیل را انتخاب می کنیم و کلیک برای رسم مربع ، ابتدا ابزار ر -

 داریم

 تنظیمات مربوط به اشکال

را انتخاب می کنیم یا روی شکل  Format Auto Shapeروی شکل مورد نظر راست کلیک کرده ، 

double .کلیک می کنیم 

 دو نوع رنگ آمیزی دارد  هر شکل

 Line Colorرنگ خط شکل  -1

 Fill Colorرنگ داخل شکل  -2
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Fill  

 

 

Fill Effect   افکت های مختلف جهت رنگ آمیزی شکل 

 
 

 

 

 

Line  

 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

Fgu 

 

 

 

 

 

Color داخل شکل رنگ  

Transparency   شفافیت 

 

 

Color خط شکل رنگ  

No line بدون خط 

Dashed   نوع خط 

Style سبک خط      

Weight ضخامت خط 
 

 

 

 

Size 
Rotation چرخش شکل 

Lock aspect ratio  حفظ نسبت تصویر 

 

 

Layout 

In line with text   نوشته ها اطراف شکل قرار می گیرند 

Square کادر اطراف شکل به صورت مربعی خواهد بود      

Tight ها تا حد امکان در اطراف شکل قرار می گیرندنوشته    

Behind text در زیر متن قرار می گیرد شکل  

In Front of text شکل روی نوشته ها قرار می گیرد 
 

 

Gradient   سایه روشن های مختلف 

Texture     یا الگو های مختلفبافت  

Pattern   الگو یا قالب های مختلف با هاشور 

Picture   شکل با تصویر انتخابی پر می شود 

 

 استفاده می کنیم.  Auto Shapeبرای رسم اشکال پیش فرض از گزینه   -

 استفاده می کنیم  Arrow keyاز دکمه های  : برای جابه جایی  اشکال  نکته  -

 می کنیم    ctrl + Arrow keyازدر صورت نیاز به جا به جایی ریز اشکال  -
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Textbox 
ابزار می توانید متن خود را در هر جای صفحه که خواستید به صورت یک کادر قرار  نوار از این با استفاده

 دهید.

 textمحو شود ، در قسمت تنظیمات مربوط به رنگ  خط     text boxدر صورتی که بخواهید کادر  توجه :

box   گزینه ،No line   .را انتخاب کنید 
 

 

  (auto shapes > Connectors) ها  connectorو استفاده از  ترسم فلو چار

) توجه کنید انتخاب و رسم می کنیم auto shape > flowchartابتدا اشکال مورد نظر را از گزینه  -

 که این اشکال باید داخل کادر رسم شکل ، ایجاد شوند.

 یم.ل را به یکدیگر وصل می کندهنده ها اشکا اتصالبا استفاده از سپس  -

Word Art 

کنید..بیشتر از این گزینه  مختلف نوشتن را ایجاد با استفاده از این گزینه می توانید  سبک ها و افکت های 

 شود. برای ایجاد عنوان اصلی استفاده می

نوع سبک ،  را ویرایش کنید ، همچنین تنظیمات مربوط word Art، متن می توانید Word Artبا نوار ابزار 

 انجام دهید.و .... را  اکاراکتر هشکل سبک ، فاصله بین 

 
Organization Chart 

بی را انتخاب مرات هسلسلپنجره ای باز می شود. نوع چارت را  organization chartبا کلیک بر روی دکمه 

فعال می    organization chartاتوماتیک  یک چارت کوچک رسم کرده و نوار ابزار     Wordمی کنیم. 

 شود. 

 organization chartنوار ابزار 
 

 

 

 

 

Insert shape  

 

 

 

 
Layout  

Subordinate زیر دست 
 

Coworker  همکار      
 

Assistant   دستیار 

Standard عادی 

Both hanging انشعاب دو طرفه       

Left hanging انشعاب از طرف چپ   

Right hanging ست   انشعاب از طرف را   

 

Select  

Level   انتخاب یک سطح 

Branchesانتخاب تمام شاخه ها 

All assistants انتخاب تمام دستیار ها    

All connecting line اتصالی انتخاب تمام خطوط   

 
استایل های  auto formatاز گزینه 

 مختلف چارت را می توانید انتخاب کنید.
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Clip Art 

 یا موضوع است.به اشکال از قبل طراحی شده ای می گویند که هر یک نشان دهنده یک مفهوم 

  wordو یا از کالری موجود در اینترنت انتخاب و در   wordمی توانید این اشکال را از گالری موجود در 

 وارد کنید.

به وجود آمده ، روی شکل راست کلیک  auto shapeنکته : برای اضافه کردن متن در اشکالی که به وسیله 

 را انتخاب می کنید.  add textکرده ، گزینه 
 Insert picture   

Insert > picture > from file 

فعال می  picture برای وارد کردن تصویر از این گزینه استفاده می کنیم. با وارد کردن تصویر نوار ابزار

 شود.
 

Color  

 

 

 

More contrast    افزایش تضاد رنگ   les contrast    کاهش تضاد رنگ 

More brightness  یی تصویر  افزایش روشنا  less brightness   کاهش روشنایی تصویر  

Crop   می توانید قسمتی از تصویر را نگه داشته ، ما بقی آن را حذف کنید ابزاربا استفاده از این  

Rotate  درجه به چپ می چرخد. 90با هر باز کلیک ، تصویر  

Line style .نوع خطوط اطراف تصویر را تعیین می کند 

Trance parent حذف پیکسل های رنگی مشابه برای  

 

 را انتخاب می کنیم.  text wrappingنکته : برای جابه جایی تصویر ابتدا یکی از حالت های 

 

از هر چیزی که در حال نمایش است       print screenمی توانید به وسیله دکمه   windowsنکته : در 

ایجاد کرده ،   text boxده ، می توانید ابتدا یک عکس بگیرید ، برای وارد کردن سریع این عکس گرفته ش

 کنید.  pasteو عکس را 

 

 

 

 

 

 

Automatic معمولی 

Grayscale تصویر خاکستری      

Black & white تصویر سیاه و سفید    

Washout تصویر مات      
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می خورد ، در این صورت اگر بخواهید   insertنکته ! گاهی اوقات موقع تایپ اشتباها دست شما به کلید 

گزین می بین نوشته ها متنی را اضافه کنید نوشته های بعد از آن قسمت پاک شده ، نوشته های جدید جای

 را می بینید.  OVRتوجه کنید موقعی که این حالت فعال باشد ، در نوار وضعیت حالت  شود ،

 را بار دیگر فشار دهید.   insertبرای جلوگیری از این اتفاق کلید 

 

 تعریف زیر نویس برای کلمات
Insert > Reference > foot note 

 قرار دهید.  normalرا در حالت   view، ابتدا    footnoteنکته : برای انجام تنظیمات مربوط به 
View > normal 

 را انتخاب می کنیم  view     ،foot noteسپس از منو 
View > foot note 

 

یرنویس در پایین صفحه باز می شود که می توان با انتخاب در این هنگام ، نوار ابزار  مربوط به تنظیمات ز

footnote separator ربوط به خط جدا کننده را انجام داد.به عنوان مثال آن را راست چین ، تنظیمات م

 کرد. !

 

 ایجاد کادر و پس زمینه برای صفحه 
Format > Border and Shading  

تنظیمات   page borderتنطیمات برای یک پاراگراف انجام می شود اما در تب   Bordersتب توجه : در 

 برای تمام صفحات انجام می شود.

 option  ،measureپیدا کند ، در قسمت  مطابقتجه : برای اینکه اندازه کادر ، با اندازه حاشیه صفحه ، تو

form   را در حالتtext   قرار داده ،  گزینهalign……  .را تیک می زنیم 

 استفاده می کنیم. Artهای گرافیکی از گزینه  کادر انتخاببرای  -

 برای گذاشتن عکس به عنوان پس زمینه 
Format > background > printed water mark 
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 ایجاد سر صفحه و پا صفحه 
View > Header and Footer 

با انتخاب این گزینه ، کادر مربوطه در بالا و پایین صفحه اضافه می شود. که می توان این کادر را به  -

 دلخواه قالب بندی کرد.

 انتخاب می کنیم.   header and footerرا از نوار ابزار   closeبعد از پایان قالب بندی ، دکمه  -

 که برای سر صفحه و پا صفحه انجام می دهیم در تمام صفحات تکرار می شود.قالب بندی توجه :  -

 

 header and footer نوار ابزار 

Insert auto text  اضافه می کند. هبا پا صفح هبعضی از تیتر های آماده را در سر صفح  

Insert page number  .شماره صفحه را وارد می کند 

 Format page numberبرای تغییر قالب شماره صفحه    

 

Insert date تاریخ را وارد صفحه می کند 

Insert time زمان را وارد صفحه می کند 

 
 

 

Page setup   تنظیمات مربوط به صفحه 

شده و در   page setupفرد متفاوت باشد وارد  سر صفحه و پا صفحه برای صفحات زوج و  برای اینکه

و برای اینکه سرصفحه و پا صفحه  را تیک می زنیم different odd and even، گزینه   layoutقسمت 

 را تیک می زنیم.  first pageبرای صفحه اول متفاوت باشد گزینه 

Show/hide document text   مخفی کردن متن نوشته ها 

 اب املائی ط یفعال کردن غل
 

 

Tools > option > spelling & grammar  
 

  auto correct ویژگیاستفاده از 

Tools > autocorrect option > auto correct  

عبارت کاملی را که می خواهیم  withعبارت اولیه را تایپ می کنیم و  در قسمت    replaceدر قسمت 

یک کادر در بالای   wordدر این حالت با تایپ عبارت اولیه ،  .جایگزین عبارت اولیه شود را تایپ می کنیم

Number format  انتخاب سبک اعداد 
Continue from previous number 

شماره هر صفحه را از ادامه شماره 

 صفحه قبل انتخاب می کند

Start at  عدد  شماره صفحه را از مقدار

 ورودی شروع می کند

Check spelling as you type  برای چک کردن غلط های املایی 

Check grammar as you type برای چک کردن غلط های گرامری    
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کلمه جایگزین   enterکلید  نفشار دادعبارت اولیه باز کرده ، کلمه جایگزین را نشان می دهد ، در صورت 

 می شود.

 نها مشکل است استفاده کنید.لمات بزرگ و یا کلماتی که تایپ آاز این ویژگی برای تایپ سریع ک
Auto text  

با استفاده از این ویژگی  بعضی از متن های از قبل آماده شده را می توانید به صفحه اضافه کنید.همچنین 

 .بعدا از آن ها استفاده کنید اضافه کنید و auto textمی توانید متن هایی را به 

 

 ترسیم جدول 
Table > inset table 

Number of column ستون ها تعداد  

Number of row تعداد ردیف ها 
 

Text behavior  

 
 

 

 ! نکته : قبل از رسم جدول ، جهت متن را تعیین کنید ، در غیر این صورت جدول چپ چین می شود

 برای حرکت بین خانه های جدول 

 استفاده کنید. shift+Tabاستفاده کنید و برای برگشت به خانه قبل از  TABبرای حرکت به سمت جلو از 

 نید با کلید های جهت دار نیز اینکار را انجام دهید.توجه : می توا

قرار داده ، علامت موس عوض شده ، با یک ، موس را بالا ستون مورد نظر  انتخاب یک ستونبرای 

 کلیک ستون مورد نظر انتخاب می شود ، 

 را نگه دارید !  ctrlبرای انتخاب چند ستون کلیک 

(  directionیا راست خارج از جدول ببرید) با توجه به  موس را به گوشه چپ  انتخاب یک سطربرای 

 علامت موس تغییر کرده و با یک کلیک ، جدول انتخاب می شود.

 به هریک از خانه های جدول یک سلول می گویند.

 می کنیم. بانتخانظر شده ، با درگ سلول ها را  موردبرای انتخاب یک یا چند سلول ، وارد سلول 

 

 

 

 

 

 

Fix column with اندازه ستون ها را می توان تعیین کرد 

Auto fit to  content  می دهد اندازه ستون ها را به اندازه کلمات داخل آن قرار  

Auto fit to windows  .اندازه ستون را به انداره صفحه قرار میدهد 
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 ها ف سلول حذ

 را انتخاب می کنیم delete cellsروی سلول مورد نظر راست کلیک کرده و 
 

 

Delete cells  
 

 

 

 

 

 ادغام کردن سلول ها 

 را انتخاب می کنیم. mergeابتدا سلول های  مورد  نظر را انتخاب کرده ، سپس راست کلیک کرده ، گزینه 

 تقسیم کردن سلول ها

باز شده ،  split، پنجره  را انتخاب می کنیم spiltکلیک راست و سپس  در خانه مورد نظر قرار گرفته ،

 تعداد سطر ها و ستون ها  را وارد می کنیم تا سلول به آن تعداد تقسیم شود.

 : برای یکسان نمودن طول خانه های جدول
 

 

Table > auto Fit 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shift cells left  کرده ، همه سلول ها را به چپ شیفت می دهد خانه مورد نظر را حذف  
Shift celles up    

ذف کرده ، محتویات خانه های زیرین را به بالا شیفت می دهدمحتویات خانه مورد نظر را ح  

Delete entire row    می کند حذفردیفی که خانه مورد نظر در آن وجود دارد را  

Delete entire column ستونی که خانه مورد نظر در آن وجود دارد را حذف می کند.    

Auto fit to content     کلمات داخل آن قرار می دهد اندازهطول ستون ها را به  

Auto fit to window اندازه صفحه قرار می دهد طول جدول را به      

Auto fit to column whit می دهد.   هم اندازه قرار طول ستون      
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 آن Interfaceو  PowerPointآشنايي با   -1

 PowerPointبا  يآشناي .1.1

 آشنايي با نرم افزارهاي ارائة مطلب .1.1.1

 ارائة مطلببه عنوان يكي از نرم افزارهاي  PowerPointمعرفي نرم افزار  .1.1.2

 نرم افزارورود به  .1.1.3

 Startمنوي  .1.1.3.1

 اجرائياستفاده از فايل  .1.1.3.2

1.1.3.2.1. C:\Program Files\Microsoft 

Office\Office14\POWERPOINT.EXE  

 Interfaceآشنايي با  .1.2

 Wordبا هاي مشترك قسمت .1.2.1

1.2.1.1. Title Bar 
1.2.1.1.1. Document Name  

1.2.1.1.2. Caption Buttons 

1.2.1.1.3.   Quick Access 

1.2.2. Ribbon 
1.2.2.1. Tabs 

1.2.2.2. Groups 

1.2.2.3. Commands  
1.2.2.3.1. Screen Tip  

1.2.2.3.2. Dialog Box Launcher   

1.2.2.4.  Tab  يا برگةFile  

1.2.2.5. Ruler 

1.2.2.6. Status Bar 

1.2.2.7. Scroll Bar  

 
1.2.3. Slide Pane 

 و انواع آن  Place Holderآشنايي با  .1.2.4

به عنوان محلي جهت نوشتن متن و يا وارد كردن عناصر  Place Holderمعرفي  .1.2.4.1

 گرافيكي

 متني .1.2.4.2

1.2.4.2.1. Title Text نوعي :Place Holder براي نوشتن عناوين موجود در هر اسلايد 

1.2.4.2.2. Body Text  نوعي :Place Holder مطالب موجود در هر  براي نوشتن

 هستند  Bulletاسلايد كه به صورت پيش فرض داراي 

 براي قرار دادن عناصر گرافيكي در داخل اسلايد Place Holderگرافيكي : نوعي  .1.2.4.3

1.2.5. Outline Tab   
هاي موجود در به عنوان محلي براي مشاهدة عناوين و نوشته Outline Tabمعرفي  .1.2.5.1

Place Holder هاي متني 

نة گزي  View Direction  دستور   View  : برگة  راست انتقال به سمت .1.2.5.2

Right to Left      هاي تركيبي فارسي و انگليسي و قرار ) جهت تصحيح متن

 ها در سمت راست متن (Bulletگيري 

 Expandو  Collapseروشهاي مختلف  .1.2.5.3

1.2.5.3.1. Double Click بر روي آيكن اسلايد در اين قسمت 
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 منوي آن    Contextاستفاده از  .1.2.5.3.2

1.2.6.  Slide Tab  محلي براي مشاهدة يك :Thumbnail صويري كوچك از هر اسلايد يا ت

 شود.كه جهت حركت بين اسلايدها استفاده مي

1.2.7. Note Pane  محلي براي نوشتن توضيحاتي در رابطه با هر اسلايد كه در زمان نمايش :

 اسلايدها مشاهده نشده ولي امكان چاپ آن وجود دارد.

 ايجاد تغييرات عمومي .1.3

   Options  General دستور File برگة روش دسترسي :  .1.3.1

  Color Schemeبا استفاده از گزينة  :تغيير رنگ  .1.3.2

   ScreenTip Style: با استفاده از گزينة  ScreenTipتغيير  .1.3.3

 Rulerتغيير در  .1.4

 Rulerحذف و اضافه كردن  .1.4.1

 Rulerفعال يا غير فعال كردن دستور  Show گروه  View برگة  .1.4.1.1

  Ribbonامكان ايجاد تغيير در  .1.5

1.5.1. Minimize  نمودنRibbon 

   : Minimizeمفهوم  دآورييا .1.5.1.1

 و باز گرداندن آن به حالت اوليه نمودن Minimizeهاي روش .1.5.1.2

 Captionدر زير كليدهاي  Minimize the Ribbonكليك بر روي علامت  .1.5.1.2.1

 ظاهر شده براي آن ( Tool Tip) توجه به تغيير شكل آن و تغيير 

 Ctrl + F1استفاده از كليدهاي تركيبي  .1.5.1.2.2

 فعال Tabكردن بر روي برگه يا  Double Clickبا استفاده از  .1.5.1.2.3

منوي هر يك از  Contextاز  Minimize the Ribbonانتخاب گزينة  .1.5.1.2.4

  هابرگه

  Ribbonتغيير در اجزاي  .1.5.2

  روش دسترسي: .1.5.2.1

 Options Customize Ribbonدستور  Fileبرگة  .1.5.2.1.1

1.5.2.1.2. Context ها منوي هر يك از برگه  دستورCustomize Ribbon 

 Ribbonحذف اجزاي  .1.5.3
 يك برگه با برداشتن علامت كنار آن ) در كادر سمت راست ( حذف .1.5.3.1

 Removeحذف يك گروه از يك برگه با انتخاب آن و كليك بر روي كليد  .1.5.3.2

 توجه به عدم امكان حذف دستورات از داخل يك گروه  .1.5.3.3

 Ribbonاضافه كردن اجزاي  .1.5.4
  Tab Newاضافه كردن يك برگه با استفاده از دستور  .1.5.4.1

  Group Newه يك برگه با استفاده از دستور اضافه كردن يك گروه ب .1.5.4.2

اضافه كردن يك دستور به يك گروه با انتخاب آن از كادر سمت چپ و كليك بر  .1.5.4.3

 Addروي كليد 

  و  Move Upها با انتخاب آنها و استفاده از كليدهايها و گروهجابجا نمودن برگه .1.5.5
Move Down   

 Renameو كليك بر روي كليد ها با انتخاب آنها ها و گروهتغيير نام برگه .1.5.6

 Restoreبه حالت اوليه با استفاده از دستور  Ribbonباز گرداندن  .1.5.7
 Reset onlyبه حالت اوليه با انتخاب دستور  Ribbonباز گرداندن تغييرات يك  .1.5.7.1

selected Ribbon tab 
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 Reset allباز گرداندن تمام تغييرات به حالت اوليه با انتخاب دستور  .1.5.7.2

customizations 

  Quick Accessايجاد تغيير در .1.6

 Quickموجود در سمت راست   Drop down menuروش دسترسي : استفاده از .1.6.1

Access 

 و باز گرداندن آن  Show Below the Ribbonتغيير مكان با استفاده از گزينة  .1.6.2

 حذف و اضافه كردن دستورات .1.6.3

 Add to Quickها با انتخاب دستور اضافه نمودن دستورات موجود در گروه .1.6.3.1

Access Toolbar  ازContext منوي آنها 

 با استفاده از گزينة : Quick Access Toolbarحذف يك گزينه از  .1.6.3.2

Remove from Quick Access Toolbar 

Contextاز  منوي آن   
 Drop Down Menu حذف و اضافه نمودن دستورات پيش فرض موجود در  .1.6.3.3

 حذف و اضافه نمودن ساير دستورات .1.6.3.4

  Drop Down Menuدر  More Commandsتور استفاده از دس .1.6.3.4.1

 Options  Quick Access Toolbarدستور  File برگة   .1.6.3.4.2

به حالت اوليه با  Quick Access Toolbarباز گرداندن دستورات موجود در  .1.6.3.4.3

  Resetاستفاده از گزينة 

 هاي مختلف نمايش  حالت -2

 هاي مختلف نمايش حالت .2.1

 Power Pointيش در هاي مختلف نماآشنايي با وجود حالت .2.1.1

  : تغيير حالت نمايشروش هاي  .2.1.2

 Presentation Viewsگروه   View  برگة  .2.1.2.1

 آيكن هاي موجود در پايين صفحه .2.1.2.2

 مختصر با انواع حالت نمايش معرفي .2.1.3

 Normalحالت  .2.1.3.1

 Slide Sorterحالت  .2.1.3.2

 Slide Showحالت  .2.1.3.3

  Notes Pageحالت  .2.1.3.4

  Reading View حالت .2.1.3.5

  Normalحالت  .2.2

 شود.به عنوان نمايي كه اسلايدها در آن ساخته مي Normalمعرفي حالت  .2.2.1

 Note Paneو  Tabsحذف قسمت  .2.2.2

 اضافه كردن قسمت هاي حذف شده  .2.2.3

  Normalدستور  Presentation Views  گروه   View   برگة  .2.2.3.1

 Status Barقسمت در   Normalآيكن  .2.2.3.2

 Draggingانجام عمل  .2.2.3.3

 Slide Tabتغيير ابعاد  .2.2.4

2.2.4.1.  Drag  نمودنSplitter خط جدا كننده   يا 

  Zoomدستور   Zoom   گروه   View  از برگة استفاده  .2.2.4.2
 Zoomقبل از انتخاب دستور  Tabs Slide نياز به فعال كردن قسمت .2.2.4.2.1



20 

 %100بيش از  Tabs Slideآشنايي با عدم امكان افزايش ابعاد قسمت  .2.2.4.2.2

  Slide Paneتغيير ابعاد  .2.2.5

 رگترين حالت ممكن مشاهدة يك اسلايد به طور كامل در صفحه و در بز .2.2.5.1

  Fit to Windowsدستور   Zoom   گروه   View  از برگة استفاده  .2.2.5.1.1

در نوار وضعيت يا  Fit Slid to Current Windowsاستفاده از دستور  .2.2.5.1.2
Status bar 

 تغيير ابعاد به دلخواه .2.2.5.2

نياز به ) Zoomدستور   Zoom   گروه   View  از برگة استفاده   .2.2.5.2.1

 دارد( Slide Paneفعال بودن قسمت 

2.2.5.2.2. Slider  يا كليد لغزندة موجود درStatus Bar 

كه باعث ظاهر شدن  Status Barدر  Zoom Levelكليك بر روي عدد  .2.2.5.2.3

  شود.مي Zoomاي كادر محاوره

  Slide Sorterحالت  .2.3

 موارد استفاده :  .2.3.1

 كنترل سازگاري ظاهري اسلايدها  .2.3.1.1

 تغيير ترتيب قرارگيري اسلايدها .2.3.1.2

 Notes Pageحالت  .2.4

شود كه در زير آن انتخاب اين حالت هر اسلايد در يك صفحة كاغذ مشاهده ميبا  .2.4.1

را  Note Paneتوان متن داخل شود و ميآن اسلايد ديده مي Note Paneمحتويات 

 ويرايش نمود

 Reading Viewحالت  .2.5

 Statusو  Title barانتخاب اين گزينه باعث به نمايش درآمدن اسلايدها مي شود اما  .2.5.1

bar ه پنجرPower Point شود و حذف نميTask bar  نيز قبل دسترس است يعني

هاي برنامهدر نتيجه دسترسي به  نيست، Full Screenنمايش اسلايدها به صورت 

 .تر خواهد بودديگر ساده

 نمايش اسلايدها .2.6

 اولبه نمايش درآوردن اسلايدها از اسلايد  .2.6.1

  F5فشار كليد   .2.6.1.1

 Fromدستور   Start Slide Show  گروه   Slide Show   برگة .2.6.1.2

Beginning 

 به نمايش درآوردن اسلايدها از اسلايد جاري .2.6.2

 From Currentدستور  Start Slide Show گروه Slide Show   برگة .2.6.2.1

Slide 

 Status Barدر  Slide Showانتخاب آيكن  .2.6.2.2

  Shift + F5 فشار كليدهاي تركيبي .2.6.2.3
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 حركت در بين اسلايدها .2.6.3

 Enter –منوي صفحه   Contextاز  Nextگزينة  - Spaceكليد :حركت به جلو  .2.6.3.1

 - Page up – Arrow key  -  كليدN 

منوي  Contextاز  Previousگزينة - Back Spaceحركت به عقب :كليد  .2.6.3.2

 Pكليد  Page Down –Arrow key –صفحه

 Slide Showخروج از حالت  .2.6.4

 Escكليد  .2.6.4.1

 منوي صفحه Contextاز  End Showگزينة  .2.6.4.2

 يتنظيمات مقدمات -3

 Layoutي با يآشنا .3.1

ها، تعداد و نحوة Place Holderانواع  كننده محل به عنوان تعيين Layoutمعرفي  .3.1.1

 قرارگيري آنها در اسلايد

 : Layoutتغيير  .3.1.2

 Layoutدستور   Slides  گروه   Home  برگة   .3.1.2.1

3.1.2.2. Context  ) منوي اسلايد ) فضاي خالي در اسلايد 

 هاي رايجLayoutآشنايي با  .3.1.3
3.1.3.1. Title Slide  حالت پيش فرض براي اسلايد اول است كه در آن دو :

Placeholder  از نوع متني برايTitle  وSubtitle .وجود دارد 

3.1.3.2. Title and Contentحالت پيش فرض براي اسلايد دوم است :.  

 Slideكردن يك  اضافه .3.2

 اسلايد قبل Layoutايجاد اسلايد با  .3.2.1

 Newصوير بالاي دستور كليك بر روي ت  Slides  گروه   Home  برگة  .3.2.1.1

Slide 

3.2.1.2. Ctrl + M 

  Outline Tabو  Slide Tabدر  Enterاز كليد  استفاده .3.2.1.3

 Outline Tabو  Slide Tabمنوي  Contextاز  New Slideاستفاده از دستور  .3.2.1.4

توجه به اين نكته كه  در اسلايد اول از هر روشي كه اسلايد جديدي اضافه )  .3.2.1.4.1

 شود (مي Title and Content آن از نوع  Layoutشود 

 دلخواه Layoutايجاد اسلايد با  .3.2.2

 Newكليك بر روي قسمت پايين دستور   Slides  گروه   Home  برگة   .3.2.2.1

Slide 

  د:ايجاد يك اسلايد از روي يك اسلايد موجو .3.2.3
 Newكليك بر روي قسمت پايين دستور   Slides  گروه   Home  برگة  .3.2.3.1

Slide   Duplicate Selected Slide 
3.2.3.2. Context  منوي اسلايد   Duplicate Slide 

 Slideحذف يك  .3.3

 از صفحة كليد  Deleteو فشار كليد  Outline Tabيا  Slide Tabدر  Slide انتخاب .3.3.1

3.3.2. Context  منويSlide Tab  وOutline Tab 

 جابجايي اسلايد در ميان ساير اسلايدها .3.4

 Draggingو انجام عمل  Slide Sorterاستفاده از نماي  .3.4.1
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نمودن آن به محل مورد  Dragو  Outline Tabيا  Slide Tabاسلايد در انتخاب  .3.4.2

 نظر

 بندي اسلايدهادسته .3.5
 ها در ويندوزبندي فايلدر دسته Folderو تشابه آن با  Sectionآشنايي با دستور  .3.5.1

 Sectionدستور   Slides  گروه   Home  برگة راه دسترسي:  .3.5.2

 Slide Sorterو  Normalدر نماي  Sectionآشنايي با امكان استفاده از دستور  .3.5.3

 :  Sectionايجاد  .3.5.4
 Add Sectionگزينه   Ribbon در  Sectionمنوي بازشونده دستور  .3.5.4.1

 Add Sectionگزينه   كليك راست بر روي اسلايدها يا فضاي بين آنها .3.5.4.2

، آن اسلايد و Sectionتوجه به اينكه با انتخاب هر اسلايد و اضافه كردن  .3.5.4.3

 ( واقع شده و امكان انتخابSectionآن زيرمجموعه يك بخش ) اسلايدهاي بعد از

 .تمامي آنها با هم وجود دارد و پرينت

 :  Sectionتغيير نام  .3.5.5
 Rename Sectionگزينه   Ribbon در  Sectionمنوي بازشونده دستور  .3.5.5.1

 Rename Sectionگزينه   Section كليك راست بر روي نوار فوقاني  .3.5.5.2

 :  Sectionحذف كردن  .3.5.6
 Remove Sectionگزينه   Ribbon  در Sectionنوي بازشونده دستور م .3.5.6.1

 Remove Sectionگزينه   Section كليك راست بر روي نوار فوقاني  .3.5.6.2

3.5.6.3.   Remove All Sections حذف تمام :Sectionهاي موجود 

3.5.6.4.   Remove Section & Slide حذف :Section  مورد نظر به همراه اسلايدهاي

 اشزيرمجموعه

 در بين اسلايدها :  Section يجابجاي .3.5.7
 Move Section Upگزينه   Section كليك راست بر روي نوار فوقاني  .3.5.7.1

 Move Section Downيا

 :  Slide Tabدر  Section جمع يا باز كردن .3.5.8
 يا Expand Allگزينه   Section كليك راست بر روي نوار فوقاني  .3.5.8.1

Collapse All 
 Sectionفوقاني  نواراستفاده از فلش موجود بر روي  .3.5.8.2

 و تغيير تنظيمات آن Placeholderكار با  -4

  Place Holderوارد كردن متن در  .4.1

قبل از نوشتن متن كه تنها جهت  Place Holderآشنايي با عبارت موجود در  .4.1.1

 شود.راهنمايي كاربر وجود دارد و در زمان ارائه مشاهده نمي

 روي آن با كليك كردن بر  Place Holderنوشتن متن در داخل  .4.1.2

  Outline Tabنوشتن متن در  .4.1.3

كردن متن به تدريج در بالاي آن ظاهر شده  Selectكه با  Mini Toolbarآشنايي با  .4.1.4

ف دسترسي پيدا ابندي متن و پاراگرترين تنظيمات قالبتوان از طريق آن به رايجو مي

 نمود.  

  File  Options  General :   برگه Mini Toolbarنحوة حذف  .4.1.4.1
Show Mini Toolbar on Screen 

 تغييرات كليايجاد   .4.1.5
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 اشكال : تغيير مكان  .4.1.6

 يكي از اضلاع آن Draggingبا استفاده از انجام عمل  .4.1.6.1

 تغيير ابعاد اشكال : .4.1.7

 موجود در اطراف آن Resize Handle هشت نمودن يكي از Drag استفاده از با .4.1.7.1

هم  Ctrlكليد از  فادهتغيير شكل عناصر گرافيكي به صورت متقارن از طرفين با است .4.1.7.2

 Draggingزمان با انجام عمل 

با استفاده از كليد  هاعرض آن بهتغيير شكل عناصر گرافيكي با حفظ نسبت طول  .4.1.7.3

Shift  هم زمان با انجام عملDragging  

 رسم شده  عناصرچرخش  .4.1.8

 Rotation Handleاستفاده از   .4.1.8.1

 Back Spaceيا  Deleteبا انتخاب آن و فشار كليد  Place Holderحذف  .4.1.9

  Styleايجاد تغيير در  .4.2

  Shape Style گروه  Format روش دسترسي : برگه  .4.2.1

 هاي موجودانتخاب يكي از گزينه .4.2.2

 توجه به تنوع در سايه ، كادر ، رنگ زمينه و . . . .4.2.2.1

  Shape Fillتغيير در رنگ شكل : از طريق دستور  .4.2.3

 هاي موجودانتخاب يكي از رنگ .4.2.3.1

 No Fillاز گزينة  برداشتن رنگ شكل با استفاده .4.2.3.2

  Pictureقرار دادن تصوير به جاي رنگ در داخل شكل : با استفاده از گزينة  .4.2.3.3
 Picture Toolbar / Formatتوجه به ظاهر شدن يك برگة ديگر به نام  .4.2.3.3.1

 Gradient: با استفاده از گزينة   Gradientتغيير  .4.2.3.4
 انتخاب يكي از حالات موجود  .4.2.3.4.1

 Gradientبرداشتن  .4.2.3.4.2

 Moreبا استفاده از گزينة  Gradientپيشرفته در  تنظيمات يادآوري .4.2.3.4.3

Gradient 

 Textureبر روي شكل : با استفاده از دستور  Textureقرار دادن  .4.2.3.5

 تغيير خط حاشيه در اشكال .4.2.4
 Shape Outlineروش دسترسي : استفاده از دستور  .4.2.4.1

 هاي موجود انتخاب يكي از رنگ .4.2.4.2

 No Outlineنة برداشتن خط حاشيه از روي شكل با استفاده از گزي .4.2.4.3

 Weightتغيير ضخامت خط با استفاده از گزينة   .4.2.4.4

كه باعث ظاهر شدن  More Lineتر با استفاده از گزينة انتخاب خطوط متنوع .4.2.4.4.1

توان از طريق آن به تنظيمات شود و ميمي Format Shapeاي كادر محاوره

 پيشرفتة اشكال دسترسي پيدا نمود.

 Dashesزگزينة تبديل خط به خط چين  با استفاده ا .4.2.4.5

 Shape Effectsهاي مختلف با استفاده از دستور  Effectاعمال  .4.2.5

 آشنايي با گروه هاي اصلي افكت ها و تغييرات ايجاد شده در آنها  .4.2.5.1

 Editتغيير شكل به شكلي ديگر بدون تغيير تنظيمات انجام شده : با استفاده از دستور  .4.2.6

Shape  در گروهInsert Shape 

 فيكي بر روي متنهاي گرااعمال افكت .4.3
  WordArt Stylesگروه  Format روش دسترسي : برگه  .4.3.1

 هاي موجودانتخاب يكي از گزينه .4.3.2
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  Text Fillتغيير در رنگ شكل : از طريق دستور  .4.3.3

 Text Outlineاز طريق دستور  : تغيير خط حاشيه در اشكال .4.3.4

 Text Effects: با استفاده از دستور  هاي مختلف Effectاعمال  .4.3.5

 گروه هاي اصلي افكت ها و تغييرات ايجاد شده در آنها يادآوري .4.3.5.1

 به حالت اوليه  Place Holderايجاد شده در تتغييراباز گرداندن  .4.4

 Resetدستور   Slides  گروه   Home  برگة  .4.4.1

 آنها ي درجو نحوه Drawingمروري بر انواع عناصر گروه  .4.5

4.5.1. Placeholder  در حقيقت نوعيTextbox  از گروهDrawing Tools  .تمام است

اين گروه از سه عنصر زير تشكيل عناصر اين گروه داراي يك برگة تنظيمات هستند. 

 شده است.
4.5.1.1. Shape  برگه :Insert     گروهIllustrations    Shapes 

4.5.1.2. WordArt  برگه :Insert     گروهText    WordArt 

4.5.1.3. Text Box  برگه :Insert     گروهText    Text Box 

 چند شكل در كنار يكديگر كار با .4.6

   Arrangeگروه   Format   روش دسترسي : برگة  .4.6.1

 تغيير ترتيب قرارگيري تصاوير بر روي .4.6.2

 Bringانتقال گام به گام يك تصوير بر روي تصاوير ديگر : با استفاده از دستور  .4.6.2.1

Forward 

 Sendانتقال گام به گام يك تصوير به زير تصاوير ديگر : با استفاده از دستور  .4.6.2.2

Backward 

 قرار دادن چند شكل در يك گروه  .4.6.3

 آشنايي با مزاياي گروه بندي تصاوير  .4.6.3.1

 تغيير مكان آنها بصورت يكجا .4.6.3.1.1

 تغيير ابعاد تصاوير بصورت يكجا و به يك ميزان .4.6.3.1.2

 حذف تصاوير با يكديگر .4.6.3.1.3

پس از انتخاب  Groupاز دستور  Groupروش گروه بندي اشكال : انتخاب گزينة  .4.6.3.2

 اشكال مورد نظر

از دستور  Ungroupبندي از روي اشكال : انتخاب گزينة برداشتن گروه روش .4.6.3.3
Group  

 Selection Paneاستفاده از ابزار  .4.7

به عنوان ابزاري براي انتخاب عناصر گرافيكي موجود در   Selection Paneمعرفي .4.7.1

 اسلايد و تغيير ترتيب قرارگيري آنها بر روي يكديگر

 روش دسترسي:  .4.7.2
 دستور  Select   بازشونده دستور  Editing  گروه   Home برگه  .4.7.2.1

Selection Pane 

 Selection Paneدستور   Arrange  گروه   Format برگه  .4.7.2.2

 مورد نظر با كليك كردن بر روي آيكن سمت راست آن مخفي كردن عناصر گرافيكي .4.7.3

ي ايجاد شده بر رو كليه عناصر گرافيكيبراي مخفي كردن   Hide Allاستفاده از گزينه .4.7.4

 اسلايد

 مورد نظر با كليك كردن بر روي آيكن سمت راست آن كردن عناصر گرافيكي ظاهر .4.7.5
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ايجاد شده بر روي  كليه عناصر گرافيكيبراي نشان دادن   Show Allاستفاده از گزينه .4.7.6

 اسلايد

 Re-Orderبرر روي يكرديگر برا اسرتفاده از كليردهاي عناصرر تغيير ترتيب قرارگيري  .4.7.7

 Send Toو   Bring To Frontمقايسه با دسرتورات ) Selection Pane درمنوي

Back) 

 Selection Paneدر  بر روي عناصر  Double clickتغيير نام عناصر با  .4.7.8

 Backgroundآشنايي با  -5

 Backgroundقرار دادن  .5.1

به عنوان رنگ يا تصويري كه به صورت پس زمينه در پشت  Backgroundمعرفي  .5.1.1

 .گيرديتمام عناصر موجود در صفحه قرار م

 روش دسترسي : .5.1.2

 Background Stylesدستور Background  گروه  Design ي برگه  .5.1.2.1

ي انتخاب يكي از پس زمينه هاي از پيش تعيين شده از منوي باز شونده .5.1.3
Background Styles 

 بر روي تمام اسلايدها  Backgroundتوجه به اعمال .5.1.3.1

 Apply toاده از دستور اعمال پس زمينه بر روي تعدادي از اسلايدها با استف .5.1.3.2

selected slide  ازContext منويBackground   مورد نظر 

  در منوي باز شونده Style 1گزينة يعني برداشتن پس زمينه با انتخاب اولين  .5.1.4

 هاي متنوعايجاد پس زمينه .5.2

 Background Formatاي استفاده از كادر محاوره .5.2.1

 هاي دسترسيروش .5.2.2

 Backgroundموجود در گروه   Dialog Box Launcherاستفاده از  .5.2.2.1

 Backgroundي از منوي باز شونده Format Backgroundانتخاب دستور  .5.2.2.2

Style 

 فعال آشنايي با اعمال تنظيمات تنها بر روي اسلايد .5.2.3

اسلايدهاي  انتخاب شده بر روي Backgroundدر صورت انتخاب چند اسلايد،  .5.2.3.1

 اعمال خواهد شد.انتخاب شده 

  Apply to Allكليد انتخاب تمام اسلايدها با استفاده از  برايه قرار دادن پس زمين .5.2.4

 هاانتخاب يك رنگ يا تركيبي از رنگ .5.3

5.3.1. Solid Color 
براي انتخاب يك رنگ براي پس زمينه از  Colorي استفاده از منوي باز شونده .5.3.1.1

 هاي پيشنهاديرنگ

 هاي متنوعبراي دسترسي به رنگ More Color استفاده از .5.3.1.2

5.3.2. Gradient fill    
 ها براي پس زمينهاعمال طيفي از رنگ .5.3.2.1

  Preset Colorsهاي رنگي پيشنهادي از قسمت انتخاب يكي از طيف .5.3.2.2

 Typeها از قسمت انتخاب يكي از حالات موجود براي هر يك از طيف .5.3.2.2.1

 Directionتغيير جهت حالت انتخاب شده با استفاده از  .5.3.2.2.2

    Angle  ي جهت انتخاب شده با استفاده ازتغيير زاويه .5.3.2.2.3

 هاي بكار رفته در طيف رنگيتغيير رنگ .5.3.2.3
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 هاي بكار رفته در طيفبه عنوان رنگ Gradient Stopsآشنايي با  .5.3.2.3.1

 Gradientانتخاب هر يك از رنگ ها و تغيير آنها با استفاده از نوار لغزاننده  .5.3.2.3.2

stops  و منوي بازشوندهColor 

يد يا كل Sliderتغيير مكان رنگ در داخل طيف با استفاده از  .5.3.2.3.3

 Positionيا با استفاده از قسمت   Gradient stopsيلغزنده

پس از انتخاب  Removeها از داخل طيف : استفاده ازكليد حذف يكي از رنگ .5.3.2.3.4

 Gradient stopsگيره آن رنگ از نوار لغزاننده 

 Addكردن يك رنگ به طيف رنگي با استفاده از كليد  اضافه .5.3.2.3.5

5.3.3. Pattern fill    
راه براي پس عمودي و نقاط و خطوط راه، تشكل از خطوط افقياي ماعمال مجموعه  .5.3.3.1

 زمينه

  Preset Colorsانتخاب يكي از الگوهاي پيشنهادي از قسمت  .5.3.3.2

  Foreground Colorزمينه الگو با گزينه رنگ پيشانتخاب  .5.3.3.2.1

 Background Color  زمينه الگو با گزينهپس انتخاب رنگ .5.3.3.2.2

 قرار دادن يك تصوير براي پس زمينه .5.4

 Picture or texture fillي فاده از گزينهاست .5.4.1

 Textureي از منوي باز شونده Textureانتخاب يك  .5.4.2

 Fileد يكل Insert from درج يك فايل تصوير از قسمت  .5.4.3

 Clip Artد يكل Insert from از قسمت  Clip Artدرج يك  .5.4.4

 Tile Picture as textureي آشنايي با فعال يا غير فعال بودن گزينه .5.4.5

شود تا ورت كوچك بودن تصوير و غير فعال بودن اين گزينه، تصوير كشيده ميدر ص .5.4.5.1

 .تمام اسلايد را بپوشاند

در صورت كوچك بودن تصوير و فعال بودن اين گزينه، تصوير در ابعاد واقعي و به  .5.4.5.2

 شود تا تمام اسلايد را بپوشاند.صورت موزائيكي تكرار مي

هاي موجود در پس زمينه با استفاده از گزينه هاي رنگي بر روي تصاويرEffectيادآوري  .5.4.6

  Format Pictureاي قسمت سمت چپ از كادر محاوره

5.4.6.1. Picture Corrections  

5.4.6.2. Picture Color  
5.4.6.3. Artistic Effects 

 برداشتن پس زمينه .5.5

 Format Backgroundاي در صورتي كه يك پس زمينه با استفاده از كادر محاوره .5.5.1

قرار داده شده باشد با استفاده  اندلايد كه قبلا انتخاب شدهيا چند اس اسلايديك بر روي 

توان آن كه در يكي از مسيرهاي زير وجود دارد مي Reset Backgroundاز دستور 

 را از روي اسلايدها برداشت.

 Format Backgroundكادر محاوه اي  .5.5.1.1

ي برگه Backgroundدر گروه  Background Styleي منوي باز شونده .5.5.1.2
Design 

و  Format Backgroundاي در صورتي كه يك پس زمينه با استفاده از كادر محاوره .5.5.2

 براي تمام اسلايده انتخاب شده باشد گزينة  Apply To Allبا استفاده از كليد 

Reset Background  غير فعال است و تنها با انتخاب گزينةStyle 1  در منوي باز

 ينه را حذف نمود.توان پس زممي Background Styleشودندة 
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 اعمال تنظيمات از پيش تعيين شده بر روي اسلايدها -6

 Themeآشنايي با  .6.1

 .شودبه عنوان تنظيمات گرافيكي و متني كه از اجزاي زير تشكيل مي Themeمعرفي  .6.1.1

  Backgroundرنگ يا تصوير  .6.1.1.1

 هاPlaceholderهاي موجود در انواع نوع و خصوصيات خطوط بكار رفته براي متن .6.1.1.2

 ن تركيب رنگي انواع عناصر قابل درج در صفحه تعيي .6.1.1.3

 ها Placeholderاندازه و محل  .6.1.1.4

الگويي كه بره صرورت  يعني Default Themeبه عنوان Office Themeآشنايي با  .6.1.2

 كند.فرض هر اسلايدي در يك ارائة جديد از آن استفاده ميپيش

  Themeاعمال  .6.2

 Themesگروه   Design  روش دسترسي: برگة  .6.2.1

بر روي اسلايد با انتقال موس بر روي هر يك از  Themeبا پيش نمايش  آشنايي .6.2.1.1

Themeها 

از مسير  Themeبر روي تمام اسلايدها با كليك كردن بر روي هر  Themeاعمال  .6.2.2

 فوق 

 اي از اسلايدها :بر روي يك اسلايد يا مجموعه Themeاعمال  .6.2.3

 Themeمنوي  Contextاز  Apply to selected Slideانتخاب دستور  .6.2.3.1

 Default Themeآشنايي با  .6.3

به عنوان الگويي كره اسرلايدهاي موجرود در يرك ارائرة  Default Themeآشنايي با  .6.3.1

 شود.ايجاد مي آنجديد از روي 
  Default Themeبه عنوان  Office Themeرفي عم .6.3.1.1

 : Default Themeبه  Themeتبديل يك  .6.3.2

 مورد نظر Theme منوي Contextاز  Set as Default Themeانتخاب دستور  .6.3.2.1

با عنوان  Style Previewآشنايي با قسمت اضافه شده به كادر باز شوندة  .6.3.2.1.1

Custom  كهTheme  انتخاب شده به عنوانDefault Theme  در آن

 قسمت قرار گرفته است.

 به حالت اوليه Default Themeباز گرداندن  .6.3.3

 Default Themeبه عنوان  Office Themeانتخاب  .6.3.3.1

 Styleدر كادر باز شوندة  Customظاهر شده در قسمت  Themeپاك كردن  .6.3.3.2

Preview  
 Themeتغيير تركيب رنگي  .6.4

به عنوان انواع تركيبات رنگي از پيش تعيرين شرده برراي  Color Schemeآشنايي با  .6.4.1

 انواع عناصر قابل استفاده در يك اسلايد

 Colorدستور   Themes  گروه   Design  روش دسترسي : برگة  .6.4.2

از  Create new theme colorنظيمات رنگي دلخواه از طريق انتخاب گزينة ايجاد ت .6.4.3

 مسير فوق
 .توان رنگ آنها را تغيير دادآشنايي مختصر با انواع عناصري كه مي .6.4.3.1

 Apply toاعمال تغييرات رنگي مورد نظر بر روي يك يا چند اسلايد با انتخاب دستور  .6.4.4

selected Slide  ازContext  منويColor Scheme 

 تغيير فونت الگوي انتخاب شده .6.5
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 Fontsدستور   Themes  گروه   Design  روش دسترسي : برگة   .6.5.1

 Titleانتخاب يكي از تنظيمات از پيش تعيين شرده كره تنظيمرات متفراوتي را برراي  .6.5.2

Placeholder    وPlaceholder Body گيرد.در نظر مي 

از طريق  Themeموجود در هاي متني Placeholderايجاد تنظيمات دلخواه براي  .6.5.3

 از مسير فوق  Create new Theme Fontانتخاب گزينة 

 Themeي يك زمينهبرداشتن عناصر گرافيكي پس .6.6

از  Backgroundدر گروه  Hide Background Graphicsي فعال كردن گزينه .6.6.1

   Designي برگه

7- Custom Animation 

 Custom Animationمعرفي  .7.1

ابزاري براي قرار دادن افكت بر روي به عنوان  Custom Animationآشنايي با  .7.1.1

 .شودكه به چهار گروه زير تقسيم مي عناصر موجود در اسلايد
7.1.1.1. Entranceشوندها در زمان نمايش اسلايد باعث ظاهر شدن عناصر مي: اين افكت. 

عناصري كه داراي افكتي از اين نوع هستند در ابتداي نمايش اسلايد در آن  .7.1.1.1.1

  شوند.ظاهر مياي افكت است كه روند و پس از اجشمشاهده نمي

7.1.1.2. Emphasis ها  در زمان نمايش اسلايد باعث تغيير بعضي از خصوصيات : اين افكت

 شوند.يك عنصر مي

7.1.1.3. Exit اسلايد ها در زمان نمايش اسلايد، باعث خارج شدن عنصر از : اين افكت

 .شودمي

7.1.1.4. Motion Pathsيد باعث حركت عناصر در ها در زمان نمايش اسلا: اين افكت

 شود.اسلايد مي

 بر روي يك عنصر Effectنحوه قرار دادن  .7.2
هررايي وجررود دارد كرره بررا اسررتفاده از گروه Animationsروش دسترسرري : در برگررة  .7.2.1

توان بر روي يك عنصر افكت قرار داد و يا افكت موجود برر دستورات موجود در آنها مي

 روي عنصر را تغيير داد.

توان وجود دارد كه از طريق آن مي  Gallery: در اين گروه يكAnimationگروه  .7.2.1.1

 افكت مورد نظر خود را انتخاب نمود.
در صورتي كه عنصر انتخاب شده فاقد افكت باشد، انتخاب يك افكت از اين  .7.2.1.1.1

 .شودقسمت باعث اضافه شدن افكت به آن مي

افكت ديگر در صورتي كه عنصر انتخاب شده داراي يك افكت باشد، انتخاب يك  .7.2.1.1.2

 از اين قسمت باعث تبديل افكت قبلي به افكت مورد نظر خواهد شد.

: در اين قسمت يك كليد از نوع باز شونده به نام Advanecd Animationگروه  .7.2.1.2

Add Animation .وجود دارد كه از طريق آن مي توان يك افكت انتخاب نمود 
يك افكت از اين  در صورتي كه عنصر انتخاب شده فاقد افكت باشد، انتخاب .7.2.1.2.1

 .شودقسمت باعث اضافه شدن افكت به آن مي

در صورتي كه عنصر انتخاب شده داراي يك افكت باشد، انتخاب يك افكت ديگر  .7.2.1.2.2

شود. در اين حالت عنصر افكت به عنصر مي آناز اين قسمت باعث اضافه شدن 

 انتخاب شده داراي دو افكت خواهد بود. 

 Advancedو  Animationگروه دو هر در ها : دسترسي به تمام افكت .7.2.2

Animation  براي هر يك از چهار گروه افكت اصلي، تنها تعدادي از پر كاربردترين

اما در قسمت پايين هر يك از اين كادرها، چهار دستور وجود  آنها قابل مشاهده است.
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شوند و با انتخاب هر يك از آنها كادري ظاهر شروع مي Moreدارد كه با عبارت 

 هاي آن گروه.شود، شامل تمام افكتيم

عددي ظاهر  آنآشنايي با شمارة افكت : با اعمال يك افكت بر روي يك عنصر، در كنار  .7.2.3

 Animation) اين اعداد تنها در صورتي كه برگة  شود كه معرف موارد زير است.مي

 شوند. (فعال باشد، مشاهده مي
 عنصر مورد نظر داراي افكت است. .7.2.3.1

هاي باشد، به تعداد افكتيك عنصر داراي بيش از يك افكت در صورتي كه .7.2.3.1.1

 شود.مشاهده ميعدد در كنار آن  اعمال شده،

ها ترتيب اجراي آنها را يعني شمارة افكت شوند.ها مطابق با شمارة آنها اجرا ميافكت .7.2.3.2

 كند.تعيين مي

 Animation Paneآشنايي با  .7.3
و سمت راست اسلايدها ظاهر شده  به عنوان كادري كه در Animation Pane معرفي .7.3.1

شوند، از بالا به پايين در آن قابل هاي موجود در اسلايد به ترتيبي كه اجرا ميافكت

 گردد.ده است. هر افكتي كه در اين كادر بالاتر قرار داشته باشد، زودتر اجرا ميهمشا

 Animation Paneاستفاده از موارد  .7.3.2
 هاي موجود در يك اسلايدمشاهدة افكت .7.3.2.1

 انتخاب يك افكت جهت تغيير خصوصيات يا نوع آن و يا حذف افكت .7.3.2.2

 هاتغيير ترتيب اجراي افكت .7.3.2.3

 ها بدون خارج شدن از محيط طراحيپيش نمايش افكت .7.3.2.4

در   Animation Pane: انتخاب دستور  Animation Paneنحوة ظاهر كردن  .7.3.3

 Advanced Animationگروه 

 نحوة انتخاب يك افكت .7.4

 Slide Paneافكت در قسمت كليك بر روي شمارة  .7.4.1

در صورتي كه يك عنصر داراي بيش از يك افكت باشد، انتخاب افكت مورد نظر در  .7.4.1.1

    به اين روش بسيار مشكل خواهد بود.  آن

 Animation Paneكليك بر روي افكت مورد نظر در  .7.4.2

 هاEffect  جابجا نمودن ترتيب اجراي .7.5

در  Reorderتفاده از كليدهاي اسو  Animation Paneدر  مورد نظرانتخاب افكت  .7.5.1

  قسمت پايين كادر

در برگة   Timingدر گروه  Move Laterو   Move Earlierاستفاده از كليدهاي  .7.5.2
Animation 

 نمودن آن به محل مورد نظر Dragو  Animation Paneدر  مورد نظرانتخاب افكت  .7.5.3

 حذف يك افكت .7.6

: اين دستور  Animationsدر برگة  Animationاز گروه  Noneانتخاب دستور  .7.6.1

نمايد. ) هاي موجود بر روي عنصر انتخاب شده در اسلايد را حذف ميافكت يا افكت

 هاي آن پاك شود را انتخاب كنيم. (خواهيم افكتابتدا بايد عنصري كه مي

از صفحة  Deleteهاي گفته شده و فشار كليد انتخاب افكت مورد نظر به يكي از روش .7.6.2

 يدكل

  Animation Paneاز منوي باز شوندة افكت مورد نظر در  Rmoveانتخاب دستور  .7.6.3
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 هاپيش نمايش افكت .7.7

يا پيش نمايش خودكار: پس از انتخاب يك عنصر با انتقال  AutoPreviewآشنايي با  .7.7.1

، يا Animationگروه  Galleryهاي موجود در قسمت موس بر روي هر يك از افكت

، آن افكت به صورت خودكار به Add Effectهاي موجود در كليد باز شوندة افكت

 شود.افكت بر روي عنصر، مجدداً تكرار مي انتخابآيد. اين عمل با نمايش در مي

 Preview گروه  Animations برگة   : Auto Previewغير فعال كردن  .7.7.1.1

   AutoPreviewغير فعال كردن گزينة  Preview  شوندة دستور باز

به  كهمحيط ويرايش از ارج شدن خها بدون مايش افكتها : يعني نپيش نمايش افكت .7.7.2

 توان آن را انجام داد.مي زير دو روش
 Animation Paneدر  Playانتخاب دستور  .7.7.2.1

 Previewدستور  Preview گروه  Animations برگة  .7.7.2.2

 نحوة شروع افكت   تعيين .7.8

به عنوان حالت پيش فرض براي اجراي هر  On Mouse Clickآشنايي با حالت  .7.8.1

 افكت 

 روش دسترسي  .7.8.2

 Animationsاز برگة  Timingدر گروه  Startاستفاده از منوي  .7.8.2.1

  Animation Paneدر Effectي مربوط به بازشونده  استفاده از منوي .7.8.2.2

 هاآشنايي با انواع حالت شروع افكت .7.8.3

7.8.3.1. On Click  : براي شروع افكت لازم است كاربر كليك نموده و يا يكي در اين حالت

 .و . . . را فشار دهد Enter ،Spaceحه كليد مانند از كليدهاي صف
در در صورت انتخاب اين حالت براي شروع يك افكت، در كنار آن يك شماره  .7.8.3.1.1

 افكت است.شود كه تعيين كنندة ترتيب اجراي مشاهده ميكنار آن 

7.8.3.2. With Previous ايش م: هم زمان با اجراي افكت قبلي و يا هم زمان با شروع ن

  و نيازي به كليك كردن ندارد. شودياسلايد اجرا م

 Animationدر صورت انتخاب اين حالت براي شروع يك افكت، در قسمت  .7.8.3.2.1

Pane شود و در قسمت ديده نميدر كنار آن اي ديگر شمارهSlide Pane 

 شود.شمارة افكتي كه اين افكت هم زمان با آن اجرا خواهد شد مشاهده مي

در موجود در اسلايد قرار داده شود، ين افكت در صورتي كه اين حالت براي اول .7.8.3.2.2

Slide Pane  شود. و در كنار عنصر مربوط به آن افكت عدد صفر مشاهده مي 

7.8.3.3.  After Previous  بلافاصله بعد از خاتمة اجراي افكت قبلي و يا درست بعد از :

آيد و نيازي به كليك كردن صورت خودكار به نمايش در مي نمايش اسلايد به

 .ندارد
 Animationدر صورت انتخاب اين حالت براي شروع يك افكت، در قسمت  .7.8.3.3.1

Pane شود و در قسمت اي ديده نميديگر شمارهSlide Pane  شمارة افكتي

 شود.كه اين افكت پس از آن به اجرا در خواهد آمد مشاهده مي

در صورتي كه اين حالت براي اولين افكت موجود در اسلايد قرار داده شود، در  .7.8.3.3.2

Slide Pane شود. و در كنار عنصر مربوط به آن افكت، عدد صفر مشاهده مي 

7.9. Time Line 
ر افكت در كنار هو  Animation Paneدر به عنوان نواري  Time Lineآشنايي با  .7.9.1

ها به صورت گرافيكي نمايش افكت را نسبت به ساير افكت آنو زمان اجراي  كه نحوه

 سازد.هم مينيز فراداده و امكان تغيير آن را 

از  Hide Advanced Timelineانتخاب دستور  :Time Lineغير فعال كردن  .7.9.2
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Context  منوي يك افكت درAnimation Pane 

 هاهاي شروع افكتهر يك از روش Time Lineآشنايي با  .7.9.3
7.9.3.1. On Click : Timeline شوند، در زير يكديگر قرار عناصري كه با كليك شروع مي

 گيرند.مي

7.9.3.2. With Previous : Timeline شوند، در زمان شروع ميعناصري كه به صورت هم

 گيرند.زير يكديگر قرار مي

7.9.3.3. After Previous : Timeline شروند، بعرد عناصري كه پس از يكديگر شروع مي

 شوند.از يكديگر ديده مي

 تغيير در زمان اجراي يك افكت .7.10
 تغيير مدت زمان اجراي يك افكت: .7.10.1

در برگة  Timingدر گروه  Duration تغيير عدد موجود در قسمت .7.10.1.1
Animations 

ضلع سمت نمودن  Dragمربوط به عنصر با  Timelineكاهش يا افزايش طول  .7.10.1.2

 Animation Pane آن در قسمت راست

 خير در شروع اجراي يك افكتايجاد تأ .7.10.2

 Animationsدر برگة  Timingدر گروه  Delayافزايش عدد موجود در قسمت  .7.10.2.1

آن در  چپ نمرودن ضرلع سرمت  Dragربوط به عنصرر برا م Timelineجابجايي  .7.10.2.2

 Animation Paneقسمت 

كاربرد : از اين قابليت بيشتر براي كنترل نحوة اجراي دستوراتي كه به صورت  .7.10.2.2.1

 گردد. شوند استفاده ميهم زمان اجراي مي

 تغيير نحوة اجراي يك افكت .7.11

در برگة  Animationدر گروه  Effect Optionsروش دسترسي: دستور باز شوندة  .7.11.1

Animations 
هاي قابل مشاهده در اين منو به آشنايي با تنظيمات قابل تغيير از طريق اين منو: گزينه .7.11.2

 از: ترين آن عبارت استكه رايج;افكت انتخاب شده بستگي دارد 
7.11.2.1. Direction ها كند و در اكثر افكتجهت اجراي افكت را تعيين مي : اين گزينه

 شود.مشاهده مي

 هادن افكتكپي كر .7.12
هاي موجود بر توان افكت: با استفاده از اين ابزار مي Animation Painterاستفاده از  .7.12.1

 روي يك عنصر را بر روي يك يا چند عنصر ديگر كپي نمود.

 Advanced Animationگروه  Animations برگة روش دسترسي :  .7.12.2

 ديگر:عنصر يك هاي يك عنصر بر روي افكتكپي كردن مراحل  .7.12.3

 .كنيمميداراي افكت را انتخاب  عنصر .7.12.3.1

كنيم. با انجام اين عمل علامت ميكليك  Animation Painterبر روي دستور  .7.12.3.2

 .مو در خواهد آمدگر موس به شكل يك قلمنشانه

خواهيم افكت بر روي آن كپي شود، كليك بر روي عنصر مقصد يعني عنصري كه مي .7.12.3.3

 گردد.كل اوليه باز ميگر موس به شكنيم. با انجام اين عمل نشانهمي

 هاي يك عنصر بر روي چند عنصر ديگر:مراحل كپي كردن افكت .7.12.4

 .كنيمعنصر داراي افكت را انتخاب مي .7.12.4.1

و بر روي آن  منتقل كرده Animation Painterگر موس را بر روي دستور نشانه .7.12.4.2

Double Click  گر موس به شكل يك كنيم. با انجام اين عمل علامت نشانهمي
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 .در خواهد آمد موقلم

كنيم. بر خلاف حالت قبل پس از اولين بر روي هر يك از عنصر مقصد كليك مي .7.12.4.3

توان گردد و به همين دليل ميگر موس به حالت اول باز نميكليك، شكل نشانه

عناصر ديگر نيز ادامه داد. براي خارج شدن از اين حالت  يعمل كپي كردن را بر رو

 را انجام داد:توان يكي از عمليات زير مي
 Escفشار كليد  .7.12.4.3.1

 Animation Painterكليك مجدد بر روي دستور  .7.12.4.3.2

 

 

 

 


